
Visual SourceSafe 2005 
Quelles sont les évolutions de la future version 

 

 

Avec la nouvelle version de Visual Studio .NET 2005 en cours en finalisation, vient la nouvelle 
version de Visual SourceSafe. Mais quelles sont les évolutions de cette nouvelle version, nous 
allons donc voir une partie de celles-ci.  

 
 
Nous allons voir dans cet article, faisant parti de la série concernant Visual SourceSafe, les évolutions visibles 
dans sa nouvelle mouture. Elle est comme Visual Studio 2005, c'est-à-dire disponible en Beta 2 :  

• Visual SourceSafe 2005 Beta 2  

 

 
 

Nous verrons dans cette présentation, les deux applications principales de Visual SourceSafe :  

• Microsoft Visual SourceSafe  
• Microsoft Visual SourceSafe Administration  

Après l'installation de cette nouvelle version, nous trouverons les liens pour chaque parties de VSS dans le 
menu suivant :  

• Démarrer > Programmes > Microsoft Visual SourceSafe  

 

Ainsi les liens se trouvent au même endroit que la version 6 précédemment installée. 

Voyons maintenant plus en détail cette nouvelle version.  



Microsoft Visual SourceSafe 
 

L'interface n'avait pas été modifiée lors de l'évolution précédente, c'est-à-dire lors du passage de Visual Studio 
6 vers Visual Studio .NET. Cette fois, cette partie a été prise en compte et intègre complètement le nouveau 
style des applications Microsoft (Office 2003 et VS.NET 2005).  

 
 

Une modification visible est dans l'ajout de Wizard, dont le premier que l'on rencontre est celui d'ouverture 
d'une base VSS. On le trouve en allant dans le menu "File" > "Open SourceSafe Database" (ou CTRL+P), il faut 
alors choisir "Add" :  

 
 



On voit maintenant apparaître le Wizard d'ajout d'un nouveau lien vers une base SourceSafe.  

 
 

En allant sur l'écran suivant, nous voyons que nous pouvons maintenant ouvrir une base déjà existante ou 
créer une nouvelle base depuis le même écran.  

 



En choisissant l'ouverture d'une base existante, nous voyons en commentaire apparaître le fait de pouvoir 
ouvrir une base SourceSafe depuis un chemin local ou depuis un partage distant, comme nous l'avons expliqué 
dans l'article précédent (Mise en place de la solution sur un partage réseau pour Visual SourceSafe 
(FR)). Le reste du process d'ouverture est le même qu'avec la version précédente. 

Il est important de préciser que la version 2005 de Visual SourceSafe ouvre sans aucun problème les bases 
créée avec Visual SourceSafe 6. 

Voyons maintenant la création d'une base SourceSafe, en choisissant la seconde option dans le Wizard, "Create 
a new database". L'écran suivant nous demande le répertoire de stockage de cette nouvelle base.  

 
 

Ensuite, nous devons donner un nom à cette nouvelle base, nous l'appellerons "VSS2005 Que Du Bonheur"  

 



L'écran suivant nous demande le mode de gestion et surtout d'accès à cette base. Ainsi, nous allons définir le 
mode de travail sur les fichiers qui seront archivés. Ainsi, nous allons choisir si nous autorisons plusieurs 
personnes à travailler sur un même fichier ou non. Nous conserverons le mode par défaut de VSS 6 pour cette 
présentation, c'est-à-dire que l'on n'autorisera pas le travail à plusieurs sur un même fichier.  

 
 

On passe alors par une fenêtre affichant un résumé de la configuration choisie pour notre nouvelle base.  

 
 

A la fin de cette création, la base se crée dans le répertoire choisi. On voit alors cette base apparaître dans la 
liste des bases SourceSafe disponible sur la machine. On peut alors l'ouvrir comme pour les autre en entrant le 
login et mot de passe adapté pour celle-ci.  

Il est important de voir que la liste des liens enregistrés dans Visual SourceSafe est commune entre VSS 6 et 
VSS 2005. De plus, la nouvelle base créée est ouvrable depuis VSS 6, ce qui permet de pouvoir travailler avec 
cette nouvelle version sur des bases créées avec l'ancienne et surtout sans être obligé de mettre à jour tous les 
postes de l'équipe.  



Microsoft Visual SourceSafe Administration 

 

A première vue l'interface d'administration est la même que celle pour Visual SourceSafe 6. L'écran d'accueil 
est sensiblement le même que dans la précédente version.  

 
 
Comme dans la version précédente, l'écran d'accueil affiche la liste des comptes existant dans la base courante.  
 
On retrouve les mêmes écrans de gestion des comptes que pour la version précédente, les interfaces sont 
simplement un peu modifiés pour entrer dans le style général de la nouvelle version. 
 
En revanche on voit rapidement que de nouveaux menus sont apparus entre l'ancienne et la nouvelle version. 
En effet, dans la version 6, nous avions les menus suivant :  

• Utilisateurs (Users)  
• Outils (Tools)  
• Archivage (Archive)  

Alors que dans la nouvelle version, nous trouvons : 

• File  
• Users  
• Tools  
• Server  
• Archive  
• Help  



Tout d'abord, "File" correspond à l'ouverture ou la création d'une base VSS, on trouvait cette partie dans Tools 
pour la précédente version.  

Le menu "Help" permet de voir les différentes aides qui ont été créées pour cette version. L'interface ressemble 
à celle de l'aide pour Visual Studio 2005.  

 
 

Voyons maintenant ce nouveau menu particulier : "Server". 

 



Configuration du Serveur 
 
Nous avons dans ce nouveau menu un unique choix :  

• Configure  

 
 

On obtient alors un écran proposant les configurations possibles en mode server.  

 
 



Dans cet écran, nous avons deux onglets pour les deux modes d'utilisation en serveur. Le premier est le mode 
serveur à travers le LAN (Serveur de fichier).  

 
 
 
On a donc un choix nous permettant d'optimiser le travail en mode serveur  

• Enable LAN service for this computer  

Cette option permet d'activer le "Lan Booster", ceci va accélérer le travail de Visual Studio .NET avec la base 
VSS. Cette option ne fonctionne qu'avec le Plugin Visual Studio et est inutile avec les autres outils de 
développement.  

La seconde configuration serveur est visible dans l'onglet "SourceSafe Internet". Ce mode permet de répondre 
aux utilisateurs de VSS pour la demande concernant l'accès quand ils ne sont pas sur leur site de travail. Ainsi 
dans un cas où le développeur est en déplacement par exemple chez un client, il peut vouloir récupérer la 
dernière version de son projet (qui a été modifié dans sa société par d'autres développeurs). Ainsi ce travail à 
travers le protocole HTTP permet de pouvoir faire cela.  

Il faut noter que ce travail à travers HTTP n'est possible que par le Plugin de Visual Studio .NET et donc pour les 
autres outils de développement, ce mode sera inutile.  



Pour cela, il faut cocher "Enable SourceSafe Internet for this computer", on peut dire que l'on active cet accès 
pour la base courante et alors spécifier le DNS du serveur qui hébergera cet accès.  

 
 

On a alors une boite de dialogue nous disant que SSL (dans le cas de ma machine) n'est pas installé et donc 
que les données ne seront pas cryptées. Elle nous demande alors si on veut vraiment installer cette option sans 
SSL.  

 
 

On a alors une fenêtre DOS ou l'on voit l'activation de l'application sur le serveur IIS.  

 



Cette application est un WebService qui est dans le répertoire d'installation de VSS.  

 
 

Dès lors, si on ouvre le fichier Web.Config de cette application, on voit une clé de configuration spécifique et 
dédiée à notre base.  

<appSettings> 
  <add key="G:\Projets \BaseVSS2005" value=""/> 
</appSettings> 

Attention :  
 
Afin de pouvoir ouvrir cette base à partir d'un client à travers Internet, il faut savoir que cette application WEB 
peut être placé sur un serveur donné et ainsi accéder à plusieurs Bases VSS différentes en ajoutant les clés des 
différentes bases mises à disposition. 
 
En revanche, ces bases ne peuvent pas être locales mais doivent être sur des serveurs de fichiers. En effet, la 
base doit déjà être exposée au LAN avant d'être mises à disposition des utilisateurs via Internet. 
Ainsi, dans notre cas, la clé d'accès à la base ne peut pas être "G:\Projets\BaseVSS2005", mais devra être 
"\\SATURNE\BaseVSS2005". Vous devrez donner tous les droits NTFS au compte faisant fonctionner les sites 
ASP.NET (en général ASPNET). 
 
Si vous souhaitez plus d'informations sur ce paramétrage, je vous invite à lire cet article :  

• Mise en place de la solution sur un partage réseau (FR)  

 

Voyons maintenant comment activer cette option dans Visual Studio .NET. 

 



Configuration de Visual Studio .NET 2005 
 
 
Le mode de travail de Visual SourceSafe 2005 en local ou sur un LAN est le même que dans la version 6. Pour 
cette partie, je vous invite à consulter les précédents articles sur le sujet.  

• Visual Studio .NET et Visual SourceSafe - Part 1 (FR)  

• Visual Studio .NET et Visual SourceSafe - Part 2 (FR)  

• Visual Studio .NET et Visual SourceSafe - Part 3 (FR)  

 
En revanche pour le mode Internet, voyons comment activer cette option sur Visual Studio .NET 2005 (à ma 
connaissance, ce n'est pas utilisable sur la version 2003 ou 2002). 
 
Tout d'abord, il faut modifier le choix du Plugin d'archivage.  

• Tools > Options  

On choisit la partie "Source Control" et aller dans "Plug-in Selection". Par défaut, le choix est fait sur "Team 
Foundation Server" qui est la nouvelle solution de gestion de source de Microsoft. Dans la liste déroulante, il 
faut donc choisir "Microsoft Visual SourceSafe (internet)".  

 
 



Attention :  

Si vous n'utilisez pas le protocole SSL, il faut absolument le spécifier à VS.NET, car par défaut, celui-ci testera 
ce mode et donc un serveur HTTPS. Pour désactiver cette option, il faut aller dans "Plug-in Settings", et cliquer 
sur "Advanced ...".  

 
 

Dans cet écran nous voyons donc le choix de SSL qui est activé, il faut donc le décocher pour travailler avec des 
serveurs HTTP non cryptés, et nous validons en cliquant sur "OK".  

 
 
 



Une fois ce choix fait, nous validons et allons paramétrer l'ouverture de cette base. Nous avons créé un projet 
vide dans Visual Studio .NET 2005 (un site WEB) et nous souhaitons ajouter celui-ci à notre base en utilisant le 
mode Internet.  
 
Pour cela, nous allons dans :  

• File > Source Control > Add Web Site to Source Control ...  

 
 

On a alors une fenêtre où on trouvera la liste des connexions SourceSafe Internet qui sont paramétrés sur ce 
serveur.  

 



Dans notre cas, nous allons ajouter une nouvelle connexion, en cliquant sur "Add". Nous obtenons alors un 
Wizard permettant de paramétrer cette nouvelle connexion.  

 
 

Maintenant, il faut paramétrer le nom du serveur (ou adresse DNS) et spécifier quelle base on veut utiliser 
(dans notre cas, "saturne"), cela en renseignant le lien UNC pour accéder à la Base (dans notre cas 
"\\SATURNE\BaseVSS2005").  

 



Visual studio va alors tester le WebService et si tout est OK, vous aurez l'écran qui vous demandera le nom que 
vous souhaitez donner à ce lien.  

 
 

Ensuite le résumé de cette nouvelle connexion VSS à travers interne.  

 



Enfin on aura cette connexion qui sera dans la liste des différentes connexions créées pour accéder à différentes 
bases VSS. On voit d'ailleurs les paramètres de chacune (URL du WebService, Partage Réseau de la base VSS 
et nom de cette connexion).  

 
 

On sélectionne cette base et clique sur "Open" pour accéder à cette base, dans notre cas, il nous avertit encore 
que nous n'utilisons pas le protocole HTTPS (HTTP Over SSL) et donc que nos données ne seront pas cryptées, 
nous pouvons faire en sorte que ce message n'apparaisse plus en cochant "Don't Warn ..." et on clique sur 
"OK".  

 



Une fois validé, nous accédons à cette base comme pour une utilisation en local et pouvons sauver ce projet 
dans cette base.  

 
 

Il nous demande alors si l'on veut créer ce nouveau projet dans cette base et une fois cliqué sur OK, tout est 
remonté sur le serveur. La fenêtre se ferme et nous voyons les cadenas apparaître sur les fichiers. On peut 
ouvrir avec le client VSS la base en question et nous voyons bien les fichiers archivés.  

 
 

Maintenant vous n'avez plus de raison valable pour refuser d'utiliser cet outil de gestion de sources. 

 



Conclusion 
 
 
Cette présentation est basée sur la version Beta  2 de Visual Studio .NET 2005, mais tout laisse à penser que 
VSS respectera cette présentation dans sa version finale. Il manquait vraiment à ce produit la possibilité de 
travailler avec à travers Internet et Microsoft a répondu à la demande. En revanche, il est évident que cette 
solution est plutôt adaptée à des petites ou moyennes équipes de développeurs. Pour les grosses équipes et 
donc les projets conséquents, Microsoft à développé un nouvel outil bien plus abouti et dans lequel la gestion 
des sources, n'est qu'une des possibilités offertes :  

• Visual Studio 2005 Team System Home (US)  

Ce produit sera une révolution dans l'usage des outils de développement Microsoft et prouve une fois de plus la 
maturité des produits de développement Microsoft basés sur le FrameWork .NET.  

 
 
 
Si vous souhaitez en savoir plus sur cet outil d'archivage de Microsoft, vous pouvez aller sur les sites dédiés :  

• Site Microsoft US pour Visual SourceSafe (US)  

• What happened SourceSafe web service access in Beta 2? (US)  

• Visual SourceSafe Web Explorer and Web Service (US)  

• Thin Client for Microsoft Visual SourceSafe on Pocket PC / SmartPhones (US)  

• Utilisation de Visual SourceSafe avec ASP.NET : VSS.net (Version 1.66 09/16/2003) (US)  

• Composant permettant d'utiliser des Bases VSS à partir d'une Interface WEB (US)  

 
 
En vous souhaitant de bons projets de développement.  
 
Romelard Fabrice (alias F___) 


